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Start Successfully 

1 Start Successfully 

1.1 About Nero Linux 
The powerful burning software Nero Linux allows you to burn your data, music and videos to 
disc. Nero Linux gives you full, customized control of your burning projects. You can − 
among other things − define the file system, the length of the file name, and the character 
set; you can also change the disc label.  
Despite its wide range of features, Nero Linux has remained an easy-to-use burning program 
that creates discs in just a few steps. You select the disc type to be burned, define the pro-
ject type, add the required data and then start burning.  

Nero Linux includes a graphical user interface that uses Nero Burning ROM, the well-known 
burn program under Windows, as a basis. 

Nero Linux is therefore the burning solution for the Linux community. 

1.2 Working With the Program 
The main function of Nero Linux is to select files and folders and to burn them to a disc. This 
is done in three basic steps: 

 In the New Compilation window, select a disc type and the disc format and set the op-
tions on the tabs. 

 In the selection screen, select files that you want to burn. 

 Start the burn process. 

See also: 

 Compilation Screen 15 

 New Compilation Window 15 

 Burn Compilation 44 

1.3 About the Manual 
This manual is intended for all users who want to learn how to use Nero Linux. It is process-
based and explains how to achieve a specific objective on a step-by-step basis. 

To make best use of this documentation, please note the following conventions: 

 

Indicates warnings, preconditions or instructions that have to be pre-
cisely followed. 

 

Indicates additional information or advice. 

 
Nero Linux 5 



Start Successfully 

1. Start … The number at the beginning of a line indicates a prompt for action. 
Carry out these actions in the order specified. 

 Indicates an intermediate result. 

 Indicates a result. 

OK Indicates text passages or buttons that appear in the program inter-
face. They are shown in boldface. 

(see…) Indicates references to other chapters. They are executed as links 
and are shown in red and underlined. 

[…] Indicates keyboard shortcuts for entering commands. 

 
Nero Linux 6 



First Steps 

2 First Steps 

2.1 Installing Nero Linux 
Nero Linux is packaged in the RPM and Debian format. These formats are used by the ma-
jority of Linux distributions. 
 

 
The RPM format is used by Red Hat Enterprise Linux, SuSE Linux and Fedora. 

The Debian format is used by Debian GNU/Linux and Ubuntu. 

To install Nero Linux, proceed as follows: 

1. Download the Nero Linux package file from www.nero.com to your computer. 

2. If you want to use a graphical interface for the installation, double-click the Nero Linux pack-
age file. 

 Your distribution's software installer tool is opened and walks you through the quick and 
uncomplicated installation process. 

3. If you want to use a terminal: 

1. Open a terminal. 
2. Go to where your package is located. 
3. To install the RPM package enter rpm -i nerolinux-<version>-<machine>.rpm 

To install the Debian package enter dpkg -i nerolinux-<version>-<machine>.deb 

 Some shortcuts will be added in the KDE and GNOME programs menu. The Debian pa-
ckage will also add a shortcut to Nero Linux in the Debian menu subsystem repository. 
You can now easily start Nero Linux over the created shortcut. 
The Nero Linux Express application is installed with Nero Linux. Nero Linux Express is a 
wizard-driven application based on Nero Linux. 

 

 
If you do not get shortcuts, you can copy the generic ones that are located in 
/usr/share/applications/nerolinux.desktop and 
/usr/share/applications/nerolinuxexpress.desktop. 

2.2 Advanced System Settings 
We recommend the following configuration of your system in order to achieve best burn re-
sult. In any case, if Nero Linux detects an incorrectly configured setting on your system, it will 
warn you when starting. 
 

 
System Configuration 

You can set Nero Linux configuration warnings in the Options window on the 
System Configuration tab. 
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2.2.1 Device File Names 

Here you will find explanations on how to find your device file names and how to set up ac-
cess to them. In Linux systems, all the devices are associated with specific files called de-
vice files. All device files that are available on your machine are located inside the /dev di-
rectory. Depending on the version of the Linux kernel you are using, your recorder device file 
name may differ due to the low-level driver it is using. 
 

 
The kernel is the heart of your Linux system. For example, the kernel provides 
low-level drivers which gain access to devices. 

 

 
How to get the Linux kernel version 

To find out which Linux kernel you are using you can enter uname –r into a ter-
minal.  

Device file names also differ according to the interface on the recorder. Currently, you can 
have many different interfaces on a recorder: IDE, SCSI, USB, FireWire (IEEE 1394) or Se-
rial ATA. 

2.2.1.1 IDE Devices 

Most internal recorders are connected to the IDE bus. Linux assigns them a device file ac-
cording to their position on this bus (bus number and master/slave settings). 

Basically, you should have the following naming convention: 

 /dev/hda : Primary Master device 

 /dev/hdb : Primary Slave device 

 /dev/hdc : Secondary Master device 

 /dev/hdd : Secondary Slave device 
 

 
If you have an additional IDE controller on your motherboard, the file names 
scheme is the same - it uses the remaining letters (for example /dev/hde and 
/dev/hdf). 

2.2.1.2 SCSI Devices 

SCSI recording devices are handled by two different drivers under Linux. Therefore two dif-
ferent device files are created to handle one physical device: 

 /dev/srX or /dev/scdX : Used only to read data from media 

 /dev/sgX : Used by Nero Linux to communicate with the device 

(X is a number identifying your device) 
If your recorder is correctly recognized by the Linux kernel it should appear in the file 
/proc/scsi/scsi. Unfortunately, there is no way to determine the X number from the SCSI co-
ordinates of your recorder. But usually the numbers are used incrementally, starting from 0, 
corresponding to the position of the device in the /proc/scsi/scsi file. 
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Usually all distributions ship a kernel configured with these options. Depending on your ker-
nel configuration, one of these files can be unavailable. In order to have both files, you 
should make sure that your kernel is configured with the following options: 

 CONFIG_SCSI (SCSI support) 

 CONFIG_BLK_DEV_SR (SCSI CD-ROM support : provides /dev/scdX) 

 CONFIG_CHR_DEV_SG (SCSI generic support : provides /dev/sgX) 

For more information about how to configure your kernel for recording CDs or DVDs, you 
can refer to the generic Linux HOWTOs. For example see  

 CD-Writing HOWTO: http://www.ibiblio.org/pub/Linux/docs/HOWTO/other-
formats/html_single/CD-Writing-HOWTO.html 

 CDROM-Writing HOWTO: http://www.ibiblio.org/pub/Linux/docs/HOWTO/other-
formats/html_single/CDROM-HOWTO.html 

 

 
Nero Linux uses /dev/sgX device files to communicate with your devices. That 
way, Nero Linux can send vendor specific commands such as those used to 
change the book type of a DVD. 

2.2.1.3 External Devices 

As all external devices are associated with a virtual SCSI device, the file name scheme is the 
same as with real SCSI devices. 
If you do not see your external device in the /proc/scsi/scsi file after you plugged it in, make 
sure that the kernel is correctly configured. For more information please refer to your Linux 
distribution documentation. 

If your external device is inside the /proc/scsi/scsi file and not present in the recorders list of 
Nero Linux, make sure you have the SCSI generic support enabled. Most of the time, load-
ing the ‘sg’ kernel module fixes this problem. 

2.2.1.4 Serial ATA Devices 

Some new recorders now come with a Serial ATA connector instead of the old IDE one. 
These devices are correctly handled with the 2.6 kernel libata. However we strongly recom-
mand to use a kernel 2.6.19 or higher to use such devices without problems. 
Serial ATA devices controlled by the libata are – like external devices – associated with a 
virtual SCSI device so they should also appear in the /proc/scsi/scsi file. 

2.2.2 IDE Devices Configuration 

2.2.2.1 IDE Devices Configuration With 2.4 Kernels  

With 2.4 kernels, all IDE devices that you want to be available in Nero Linux must use the 
ide-scsi driver (even CD/DVD readers). This driver associates a virtual SCSI device with a 
standard IDE device.  
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Usually, Linux distributions automatically configure everything so that only recorders use this 
driver. In such cases, you will not be able to use your CD or DVD readers in Nero Linux and 
you have to make the device use the ide-scsi driver. 

Before you configure a device, make sure that you have configured your kernel with the fol-
lowing options: 

 CONFIG_BLK_DEV_IDESCSI (SCSI emulation support) 

 CONFIG_SCSI (SCSI support) 

 CONFIG_BLK_DEV_SG (SCSI generic support) 

Configuring a device so that it will use the ide-scsi driver is done by providing a specific ar-
gument hdx=ide-scsi to the kernel command line. For example, if the device file correspond-
ing to your recorder is /dev/hdb, you will have to provide hdb=ide-scsi to the kernel command 
line. 
If you do not know how to do this refer to your distribution documentation to find out how to 
pass options to the kernel at boot time. Note that most of the actual distributions provide so-
me graphical frontends to modify the boot loader parameters:  

 For Red Hat Linux run ksconfig (this application is called Kickstart Configurator). 
When the application is running, click Boot Loader Options and fill the Kernel Parame-
ters field. 

 For SuSE Linux run YaST2, select System in the left pane and then double-click Boot 
Loader Configuration. Once the module is launched, click Edit Configuration Files to 
set up the device parameters. 

2.2.2.2 IDE Devices Configuration With 2.6 Kernels 

With 2.6 kernels, the native IDE CD-ROM driver called ide-cdrom has been completely re-
written to use the latest technologies available and permit optical disc recording. This driver 
includes DMA acceleration that lets you use high-speed devices (like DVD recorders). 
Accordingly, the ide-scsi driver (that has been used with lower version kernels) has been de-
precated. If you continue using this driver with a 2.6 kernel your devices will not be available 
with Nero Linux (note that you will also receive a warning message from the kernel at boot 
time).  

In order to use an IDE device with Nero Linux under a 2.6 kernel, you must associate it with 
the ide-cdrom driver. Therefore, the kernel command line must not be associated with the 
"old", ide-scsi driver (no hdXX=ide-scsi parameter). 

If you do not know how to do this refer to your distribution documentation. 

2.2.3 Setting Correct Permissions on the Devices Files 

2.2.3.1 Setting Permissions For Static "/dev" Support 

If you want to give other users access to all disc devices you can do this in Linux by setting 
correct permissions for corresponding device file names. This takes place in the operating 
system and not in Nero Linux. 
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Requirements: 

 You have enough privileges to do so. 

To set up correct permissions on your device files, proceed as follows: 

1. Open a terminal. 

2. Type the following command (where X is the letter corresponding to the IDE device): 

1. chmod o+r+w /dev/sg* 
2. chmod o+r+w /dev/hdX  

3. You can run the last command more than once if you have multiple IDE devices. 

 Users are given read and write permission on all your SCSI generic devices (CD-ROM 
for example) and your IDE disc devices. 

 

 
If you only want to give access to some users, another possibility is to create a 
new group called for example "nero" and change the group of the device files 
corresponding to your disc devices with it. Then give read/write permission to 
the group on these device files and finally, just add all the users that are al-
lowed to use Nero Linux to the newly created group 

2.2.3.2 Udev Support 

Nero Linux supports udev, the new /dev file system implementation that is used in actual Li-
nux distributions.  
With this file system, all permissions are set during boot time using some specific configura-
tion files. In order to make your modifications permanent, you have to change the files lo-
cated in /etc/udev/rules.d. For more details, you can have a look at the udev FAQ. 

In some rare cases a hotplug device that gets plugged in when Nero Linux is already started 
might not be recognized directly. In such cases, simply restart Nero Linux. 

2.2.4 Setting up DMA Acceleration on IDE Devices 

DMA acceleration provides an improvement in throughput for the disc drives and lets you sa-
fely use all your recording devices. Depending on your Linux kernel and distribution configu-
ration you might have DMA acceleration that is automatically enabled at startup. 
If your hardware supports it, we recommend enabling DMA acceleration not only for IDE 
hard drives, but also for disc drives such as CD/DVD readers and recorders. 

This takes place in the operating system and not in Nero Linux. 

If one of your devices does not have DMA acceleration, Nero Linux will warn you when start-
ing the application. 

Proceed as follows to activate the DMA acceleration on a device: 

1. Type the following command as root: hdparm –d1 /dev/hdX  
(where X stands for the letter that corresponds to the IDE device) 

 DMA acceleration is activated. 
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This setting is not permanent. If you want to enable DMA at boot time, you can 
add the command above in one of your startup scripts. As these scripts are dis-
tribution dependant, please refer to your distribution documentation to find out 
how to do this. Please note that most of the distributions have some graphical 
frontends to configure this. 

2.3 Enter Serial Number 
By opening Nero Linux or Nero Linux Express for the first time, you have to enter your name 
and serial number in order to activate the program. The activation will be valid for both appli-
cations. 
However, you always have the option of entering a new serial number in the program after-
wards. 
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3 Main Screen 
The main screen of Nero Linux is the starting point for all actions. It consists of a menu bar 
and a toolbar with buttons and a drop-down menu. 

 
Main window with menu and toolbar 

The following menus are available: 

File Provides program facilities such as opening, saving, and closing. You can 
also open the setting options for the compilation, update the compilation, 
and define configuration options. 

Edit Provides editing facilities for the files in the selection screen such as cutting, 
copying, and deleting. You can also display the properties of a selected file. 

View Provides the option to customize the user interface and to refresh the file 
browser. 

Recorder Provides recorder facilities. You can select the recorder here, start the burn 
process, and erase a rewritable disc. You can also eject a disc and display 
disc information. 

Extras Provides the option to convert tracks into other formats and to save the 
songs on an Audio CD to the hard drive. 
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Window Provides the option to alter the position of the compilation area and browser 
area. 

Help Shows information about the application. You can also enter a new serial 
number. 

The following configuration options are available in the tool bar of the main screen. 

 Opens the New Compilation window where you can set options for a burn 
or copy process. 

 Opens an existing compilation. 

 Saves the active compilation. 

 Cuts selected elements in the compilation (selection). 

 Copies selected elements of the compilation (selection). 

 Pastes a selection that was cut or copied beforehand. 

 Starts the burn process by opening the Burn Compilation window contain-
ing the Burn tab. 

 Starts the copy process by opening the New Compilation window contain-
ing the Burn tab. 

 Displays information on the disc inserted, such as contents (if any) and ca-
pacity for instance. 

 Opens the selected drive. 

 Shows or hides the file browser. 

 Displays the user’s home folder contents in the file browser. 

Recorder 
selection 
menu 

Displays available recorders. 

 Opens the Choose recorder window where you select an available re-
corder for the burn process from a list. 

 Displays information on the program and version number. 

 
Plays an audio file that is dragged from the compilation to the button. 
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4 Compilation Screen 

4.1 New Compilation Window 
In the New Compilation window you can select the disc type and configure the options for 
the disc format. The window basically looks the same for all disc types. The only difference is 
the tabs that are available. When you start Nero Linux, the New Compilation window opens 
automatically. If the window is not open, click the New button. The window consists of a 
drop-down menu, a selection list, various tabs, and buttons.  

 
New Compilation window, CD-ROM disc type 

If the Image Recorder is not enabled, only those disc types supported by the recorder are 
displayed in the drop-down menu. If the recorder can only burn CDs, the drop-down menu is 
grayed out. 

 

 
Using Nero Linux you can create image files for disc types that the installed re-
corder cannot burn. You can enable this function via the File > Options > Ex-
pert Features menu, Enable all supported recorder formats for image re-
corder check box. The drop-down menu in the Compilation window then ma-
kes available all supported disc types. 
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The following entries are available in the selection list: 

Entry 

CD/DVD-ROM/Blu-ray 
(ISO) 

Creates a data disc, each file type can be burned. The burned 
data complies with the ISO standard. 

Entry 

Audio CD 

Creates a standard Audio CD that can be played on all (audio) 
CD players at least. 

Entry 

Mixed Mode CD 

Creates a CD with data and audio files in a single session. 
Usually a data file is followed by one or more audio files for in-
stance (e.g. soundtrack for PC games).  

Older Audio CD players are often not capable of recognizing 
the data file and attempt to play it. 

Entry 

CD EXTRA 

Creates a multisession CD with audio and data files that are 
stored in two sessions. The first session contains the audio files 
and the second session the data.  

Common CD players play the first session as Audio CDs. The 
second session can only be used by PCs with a CD-ROM drive, 
it cannot be recognized by a normal CD player. 

Entry 

CD/DVD/Blu-ray Disc 
Copy 

Copies a source disc to a CD/DVD/Blu-ray Disc. 

Entry 

miniDVD 

Creates a CD that uses the specifications of a DVD. The mi-
niDVD has the same technical options and qualities as a DVD. 
It can easily be played on a PC, whereas there is no guarantee 
that it can be played in all DVD players.  

You can use Nero Linux to burn a miniDVD if the DVD video ti-
tle, i.e. a complete DVD folder structure, is already available. 

Entry 

CD/DVD-ROM/Blu-ray 
(Boot) 

Creates a bootable disc. 

Entry 

CD/DVD-ROM/Blu-ray 
(UDF) 

Creates a data disc; all file types can be burned. The burned 
data complies with the UDF standard. 

Entry 

CD/DVD-ROM/Blu-ray 
(UDF/ISO) 

Creates a data disc; all file types can be burned. The burned 
data complies with the ISO and UDF standards. 

Entry 

DVD-Video 

Creates a DVD that delivers high-quality playback of video 
and/or picture files on DVD players.  

You can use Nero Linux to burn a DVD if the DVD video title, 
i.e. a complete DVD folder structure, is already available. 
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The actual entries that are available and the actual disc types (e.g. DVD) to 
which can be written depend on the used recorder. 

 

 
You can find more information on Blu-ray support at 
www.nero.com/link.php?topic_id=416. 

The following buttons are available: 

Button 

Open 

Opens a file browser where you can find and open a saved compila-
tion. You can also open an image file in order to burn a disc. 

Button 

New 

Creates the selected compilation and displays the selection screen 
where you can select the files for burning. 

Button 

Cancel 

Closes the New Compilation window. 

You can set the options for the respective disc format on the tabs in the New Compilation 
window.  

 

 
Which tabs are available depends on the disc type that is selected. 

The following tabs are available: 

Tab 

Info 

Shows statistical information on the compilation. 

Tab 

Multisession 

Contains options for configuring multisession discs. 

This tab is only available if a burner is installed. 

Tab 

ISO 

Contains options for configuring the ISO file system. 

Tab 

UDF 

Contains options for configuring the UDF file system. 

Tab 

Label 

Defines the labels of the disc. 

Tab 

Dates 

Allows you to define the dates of the compilation and of the associ-
ated files. You can also specify a validity period for the disc.  

You can access the data regardless of the validity period specified. 

Tab 

Misc 

Defines whether (and if so, which) files are stored in the buffer me-
mory. 

Tab 

Audio CD 

Contains options for configuring audio files.  

You can also enter additional information about the CD. 
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Tab 

Boot 

Contains options for configuring a bootable disc. 

Tab 

Burn 

Contains options for configuring burning. 

See also: 

 Multisession Settings 22 

 ISO Settings 22 

 UDF Settings 24 

 Audio CD Settings 27 

 Burn Compilation Window 48 

 Burn Settings 49 

 Copy Settings 54 

4.2 Selection Screen 
The selection screen is the starting point for work that you want to do on compilations. The 
selection screen is displayed in the main screen after you select the disc type and format 
and click the New button. The selection screen consists of the compilation area, the browser 
area and a capacity scale. 

 
Selection Screen 
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The compilation area is named after the relevant compilation. Files and folders are compiled 
here for burning. In the browser area (File Browser) you can find the elements that you want 
to burn. 
The bottom margin of the screen contains a capacity scale in MB for data discs or minutes 
(min) for Audio CDs. The exact size of the scale will depend on which disc type you have se-
lected. 

 

 
You can switch the units of the capacity scale by double-clicking on the scale. 

 

 
If the Browser area is hidden, you can show it again using the  button. 

When you are compiling files, a capacity bar indicates how much space the files need on the 
disc. The color of the capacity bar indicates whether the data will fit on the disc or not: 

Green capacity bar The data will fit on the disc. 

Yellow capacity bar 
(from the yellow mark 
on the scale) 

The data might fit on the disc. The size of the disc that has 
been inserted will determine whether the data will fit or not. 

Red capacity bar 
(from the red mark on 
the scale) 

The data will not fit on the disc.  

(Unless you have inserted an oversize disc.) 

The yellow and red marks are set by default for discs that are commercially available. The 
disc type you have selected will determine the exact scale value. 

 

 
Capacity of the CD recordable disc 

For example, blank CDs are available with a capacity of 650 MB or 700 MB. 
Therefore the yellow mark is set for CDs at 650 MB and the red at 700 MB. 

 

 
Display the Capacity Bar 

If the capacity scale is hidden you can display it again by clicking the File > Op-
tions > Compilation menu and by selecting the check box Show the compila-
tion size in the Nero status bar. 
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5 Data Disc 

5.1 Compiling Data Disc 
With Nero Linux you can compile and burn all types of files and folders. If a Blu-ray recorder 
is installed on your computer you can burn data CDs, data DVDs and data Blu-ray Discs. If 
you have a CD recorder you can only burn data CDs. The procedure for all data compilation 
methods is identical. 
 

 
The Image Recorder is also suitable for creating an image of a disc type not 
supported by the connected recorder. For example, you can therefore create a 
DVD image without having installed a DVD recorder. You can then write the 
image to a disc at any time. 

To create a data disc, proceed as follows: 

1. Select the desired disc format (CD, DVD, Blu-ray) from the drop-down menu in the New 
Compilation window. (In the case that the New Compilation window is not opened, it can 
be opened by clicking the New button on the main screen.) 

 The selection list shows the compilation types that can be burned. 

 
New Compilation Window 
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2. Select the desired compilation type for a data disc from the selection list (CD/DVD-ROM/Blu-
ray Disc (ISO), CD/DVD-ROM/Blu-ray Disc (UDF), or CD/DVD-ROM/Blu-ray Disc 
(UDF/ISO). 

 The tabs with the configuration options that are valid for this compilation type are dis-
played. 

3. Set the options you require on the tabs. 

4. Click the New button. 

 The New Compilation window is closed and the selection screen is displayed. 

 
Compilation screen 

5. Select the files/folders that you want to burn from the browser area.  

6. Drag the required files/folders into the compilation area on the left side. 

 The files are added to the compilation and displayed in the compilation screen. The ca-
pacity bar indicates how much space is required on the disc. 

7. Repeat the previous step for all files that you want to add. 

 You have successfully compiled a data disc and can now burn this compilation. 

See also: 

 Burn Compilation 44 
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5.2 Defining Options 

5.2.1 Multisession Settings 
The Multisession tab provides the option to create multisession discs for data discs. Multis-
ession discs can be burned in multiple sessions until you have reached the maximum disc 
capacity. A session is a self-contained data area that is burned using a single process, and 
consists of a lead-in (with the table of contents), one or more tracks, and a lead-out. Discs 
without the multisession option, e.g. Audio CDs, are burned in a single session. 
If a new multisession disc is being started, Nero Linux also saves (if possible) the point of 
origin for the files. This information is used when continuing the multisession disc.  
If a multisession disc is being continued, Nero Linux automatically sets a cross reference to 
the imported session, i.e. the table of contents for the imported session is copied to the table 
of contents for the current session. You must define which session is being imported at the 
start of the burn process. The files in the previous sessions are retained and continue to take 
up space. 
In this case Nero Linux automatically verifies whether the correct multisession disc has been 
inserted for continuation. If not, the disc is ejected. 
 

 
If you disable the Finalize disc check box on the Burn tab, you can always 
burn additional sessions on the disc, but then only the last session will be visi-
ble and you will only be able to access data from the final session. 

 

 
Multisession disc 

Multisession discs are particularly suitable for backing up important files burned 
on a regular basis.  

The following configuration options are available on the Multisession tab in the Multises-
sion area: 

Option button 

Start Multisession 
disc 

Burns the selected compilation in one session to the disc. 

If the disc already contains sessions, you can also select this 
option. Sessions are then not imported and cross references 
are not set. 

Option button 

Continue Multisession 
disc 

Continues a multisession disc by burning an additional session 
to a disc with at least one session. Cross references to the im-
ported session are set in the process. 

Option button 

No Multisession 

Creates a disc without a multisession. 

5.2.2 ISO Settings 
The ISO tab provides options for configuring the ISO file system. 
ISO 9660 is a system-independent standard. It can be read on all operating systems.  
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The following features apply: 

 Permits eight characters (Level 1) or 31 characters (Level 2) for the file name. 

 Permits eight characters for the folder name. 

 Restricts the maximum directory depth to eight levels (including root folder). 

 The characters A-Z, 0-9 and the underscore (_) are permitted. 

In the ISO tab, in the area Relax Restriction, the restrictions imposed by the selected file 
system can be relaxed. For example, you can allow a higher path level or more than 64 cha-
racters for the Joliet name. 
 

 
If the disc should be read on all operating systems, select ISO 9660 as the file 
system and clear all check boxes in the Relax restrictions area. 

 

 
If the disc is to be used mainly on computers with Microsoft Windows and you 
want to use lowercase letters and/or foreign language characters for the file 
names, select ISO 9660 + Joliet as the file system. 

The following setting options are available on the ISO tab in the Data and File areas: 

Drop-down menu 

Data mode 

Selects the mode for the data. Mode 1 and Mode 2/XA are 
available. Newer drives can easily read Mode 1 and Mode 2/XA 
CDs. 

However, some older drives cannot read Mode 1 discs cor-
rectly. In the case that the disc is to be able to be read in any 
case on older drives, select the Mode 2/XA format. 

Drop-down menu 

File system 

Selects the file system that is used for the data. 
ISO 9660 only: ISO format alone is used.  
ISO 9660 + Joliet: ISO format is used and is enhanced by the 
Joliet standard. 
ISO 9660:1999: The latest ISO format update is used. Among 
other things it allows the use of 207 characters and a deeper 
directory depth. 

Drop-down menu 

Length of file name 

Defines the possible length of the file name. Level 1 and Level 
2 are available. In Level 1 the file name can be eight characters 
long and the file name extension (e.g. *.doc) three characters. 
In Level 2 the file name can be 31 characters long. 

Drop-down menu 

Character set 

Defines the character set used for ISO names. 

Drop-down menu 

Add Rock Ridge ex-
tension 

Adds a Rock Ridge extension to add POSIX rights to the items 
on Unix systems.  
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5.2.3 UDF Settings 
The UDF tab provides options for configuring the UDF file system. The UDF standard was 
developed by Osta (Optical Storage Technology Association) in response to the require-
ments of DVDs. The standard works on all platforms. 

The following setting options are available in the Options drop-down menu: 

Entry 

Automatic Settings 

Sets options automatically for the UDF file system. 

We recommend that you select this entry. 

Entry 

Manual Settings 

Enables you to manually define the UDF partition type and the 
file system version. 

Entry 

Enable Xbox compati-
bility mode 

Creates a disc that is compatible with an Xbox.  

This entry is available if the No Multisession option button is 
selected on the Multisession tab. 

 

 
A disc that is compatible with Xbox cannot be created as a multisession disc. 

 
Nero Linux 24 



Audio CD and Audio Files 

6 Audio CD and Audio Files 

6.1 Compiling Audio CDs 
Using Nero Linux you can create an Audio CD that contains music files. It can be played us-
ing all standard CD players. To compile an Audio CD, source files with different audio for-
mats are automatically converted into Audio CD format before being burned. 
 

 
Some CD players cannot play CD-RWs. Use CD-R discs to burn Audio CDs. 

To create an Audio CD, proceed as follows: 

1. Select the CD entry from the drop-down menu in the New Compilation window. (In the case 
that the New Compilation window is not opened, it can be opened by clicking the New but-
ton on the main screen.) 

2. Select the Audio CD compilation type from the selection list. 

 The tabs with the configuration options that are valid for this compilation type are dis-
played. 

 
Audio CD 
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3. Set the desired options on the tabs. 
 

 
Audio CDs should always be burned using the disc-at-once method. This entry 
is selected by default. 

4. Click the New button. 

 The New Compilation window is closed and the selection screen is displayed. 

5. Select the audio files that you want to burn from the browser area on the right side. The au-
dio file can come from the hard drive or from an Audio CD.  

6. Drag the desired audio files into the compilation area on the left side. 

 The files are added to the compilation and displayed in the compilation screen. The ca-
pacity bar indicates how much space is required on the disc. 

 
Compilation screen - Audio CD 

7. Repeat the previous step for all audio files that you want to add. 

8. Customize the properties of the audio file to suit your requirements. 

 You have successfully compiled an Audio CD and can now burn this compilation. 

See also: 

 Burn Compilation 44 
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6.1.1 Audio CD Settings 
The Audio CD tab provides options for setting the Audio CD. 

 
Audio CD Tab 

The following configuration options are available on the Audio CD tab in the General area: 

Check box 

No pause between 
tracks 

Allows the audio files to merge into one another on the Audio 
CD without a pause (just like in live recordings).  

If the check box is cleared, there are pauses of two seconds 
between the audio files. 

The following configuration options are available in the CD Text area: 

Check box 

Write on CD 

Enables the option for writing CD TEXT. With CD players that 
support CD TEXT, the title of the CD, the name of the audio file 
as well as the name of the artist appear in the display. 

Input field 

Title 

Defines the label of the Audio CD. 

Input field 

Artist 

Defines the artist. 

You can also enter additional information about the Audio CD such as the producer or com-
ments. 
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6.1.2 Track Properties Tab 
On the Track Properties tab you will find basic information on the selected file in the Sour-
ce information area. To open the window, mark an audio file in the compilation screen for 
Audio CDs and click the Edit > Properties menu.  

 
Track properties 

The following input areas are available in the Properties area: 

Input field 

Title (CD TEXT) 

Defines a title which is saved as CD TEXT. 

CD players that support CD TEXT show the title name entered he-
re. 

Input field 

Artist (CD TEXT) 

Defines the artist which is saved as CD TEXT. 

CD players that support CD TEXT show the artist's name entered 
here. 

Input field 

Pause 

Defines the length of the pause in seconds or frames between the 
selected audio file and the next one. 

Input field 

International Stan-
dard Recording 
Code (ISRC) 

Identifies the CD title using a 12-character digital code. The ISRC is 
entered in the subcode and included silently. 

If you do not know the ISRC, you should leave this input field blank. 

Check box 

Protection 

Enables copy protection. 
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 
 

6.2 Mixed Mode CD and CD EXTRA 
With Nero Linux you can compile CDs that include both audio and data files. 

The following compilation methods are available: 

Mixed Mode CD 

CD EXTRA 

A Mixed Mode CD includes the data and the audio files in one session. CD EXTRA includes 
the audio files in the first session and the data files in the second session. 
The procedure for compiling the audio and data files is basically the same as the procedure 
for compiling data or music CDs. Please be sure to select the corresponding entry in the 
New Compilation window. The selection screen includes a compilation area for audio files 
and one for data files. 

See also: 

 Burn Compilation 44 

 Compiling Audio CDs 25 

6.3 Copy Audio CDs to Hard Drive 
With Nero Linux you can save audio files from an Audio CD to the hard drive. In the process, 
the files are encoded, i.e. converted into a format that the computer can read. The audio file 
is usually compressed. 
The Audio CD can be automatically identified with freedb. That way you have audio files that 
are accurately and fully named after the encoding process. 

 

 
Internet Database freedb.org 

Nero AG is not responsible for the www.freedb.org website, but just provides an 
interface to it. 

 

 
Audio files from copy-protected Audio CDs cannot be saved. 

To save audio files, proceed as follows: 

1. Click the Extras > Save Tracks menu. 

 The Save Tracks window is opened. The Audio CD content is displayed. 
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Save tracks 

2. If you want the metadata to be filled out automatically, click the Internet DB button. 

 The disc is analyzed and the required information is sent to freedb. If a matching entry is 
found then that metadata will be used and displayed. 

3. If necessary, edit the metadata (title, artist, album title, year, genre). 

4. Click the Output tab. 

 The Output tab is opened. 
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Save tracks - Output 

5. Select the target file's audio format in the File Format drop-down menu 

6. Select a method for creating the file name in the File name creation mode drop-down me-
nu. 

7. Define other settings according to your preferences.  

8. Click the Save Tracks button. 

 Conversion starts. The audio files are saved and named according to the method you 
chose.  

 If you chose the Manual file name creation mode, a window is opened for every track. 
Here you can enter the individual file name. 

 The Progress window indicates the saving progress. When the save process is com-
plete, this window is closed automatically. 

9. Click the Close button. 

 The Save Tracks window is closed. You have saved your audio files. 
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6.3.1 Save Tracks Window 
In the Save Tracks window you can define the settings for the audio files that are to be sto-
red on the hard drive. You can open the window by clicking the Extras > Save Tracks me-
nu. 

 
Save Tracks - Source 

The following setting options are available: 

Tab 

Source 

Specifies settings for the source of the audio data. 

Tab 

Output 

Sets output files configuration options. 

Button 

Save Tracks 

Starts the save process. 

Button 

Close 

Closes the window. The audio files will not be saved. 

6.3.1.1 Source Tab 
The Source tab displays the audio files on the Audio CD. The functions of the control but-
tons correspond to the familiar control buttons on CD players.  
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The following setting options are available: 

Drive drop-down 
menu 

Selects the drive in which the Audio CD is inserted. 

Title list Displays the audio files on the Audio CD. 

Area 

Properties 

Displays the properties of the selected audio track. 

Button 

Internet DB 

Sends a query to the Internet database www.freedb.org and com-
pletes the properties of the Audio CD, such as title name, if an ap-
propriate entry exists in the Internet database.  

 

 
Internet Database freedb.org 

Nero AG is not responsible for the www.freedb.org website, but just provides an 
interface to it. 

6.3.1.2 Output Tab 
You can define the properties of the audio files to be created on the Output tab. 

 
Save tracks - Output 
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The following setting options are available: 

Input window 

Output directory 

Selects the storage location for the output file. 

Button 

Browse 

Opens a browser window where you can select a storage location. 

Selection list 

File name creation 
mode 

Selects the method to be used for creating the name of the output 
file. 

Button 

Settings 

Opens a window where you can specify how the file name should 
be created. The methods Automatic, Manual, and User Defined 
are available. 

Check box 

Automatically ge-
nerate a playlist of 
stored audio 
tracks 

Creates a playlist of the saved audio files. 

Selection list 

File format 

Selects the output audio format for the selected audio file. 

Button 

Settings 

Opens a window where you can define options such as bit rate and 
frequency of the output audio file. 
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6.4 Encode Files Window 
In the Encode Files window, the audio files that are to be encoded are selected and the 
properties of the output are defined. You can open the window via the Extras > Encode Fi-
les menu. The window consists of a selection area and the Properties area. 

 
Encode Files Window 

The following configuration options are available in the selection area: 

List 

Files to be encoded 

Displays the selected files. 

Check box 

Show full paths 

Displays the full source and destination paths for the files in the 
Files to be encoded list. 

Button 

Add 

Opens the browser window where you can select a file to add it to 
the list of files to be encoded. 

Button 

Remove 

Removes the selected file. 

Button 

Remove All 

Removes all files from the list of Files to be encoded. 

Button 

Reset Status 

Resets the status of the selected file to to do. 
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cess. Button 

Go 

Starts the encode pro

Button 

Close 

Closes the window. 

T ration options are available in the Properties area: 

wn menu 

e format 

he following configu

Drop-do

Output fil

Selects the output audio format for the selected audio file. 

Button 

Settings 

Opens a window where you can define options such as bit rate 
and frequency for the output audio file. 

Display panel 

on folder Destinati

Displays the storage location of the output file or output files. 

Button 

Browse 

Opens a browser window where you can select a storage loca-
tion. 

Display panel Displays information on the selected audio file. 

Source file info 

6.5 Enco

Set options in  button. Settings are 
available for t

ding Options 
Nero Linux can encode audio files in different formats. 

 the respective window that you can open via the Settings
he MP3, Nero Digital Audio, OGG Vorbis, and WAV output file format. 

 
MP3 Configuration options 

 



Audio CD and Audio Files 

 
Nero Linux 37 

T g op

he scan rate per second and thus determines the fre-

he following settin tions are available: 

Specifies tDrop-down menu 

Sample Rate quency of scanning. The higher the frequency, the more frequently 
scanned. 

Drop-down menu 

Encoder quality e more value on fast encoding 
 superior psychoacoustic encoder model 

Specifies the encoder quality. Fast and Highest are available. The-
se settings specify whether you plac
(Fast) or more value on a
for the very best results (Highest). 

Only available for MP3. 

Drop-down menu 

Constant Bit Rate 

 

ile is then small, 
is high, more data is transferred. 

Selects a constant bit rate, i.e. the data flow per unit of time and the
quality of the saved data are the same over the entire audio file. If 
the bit rate is small, less data is transferred. The f
but quality is lower. If the bit rate 
The file size is then large, but the quality is high. 

Not available for WAV Encoder. 

Drop-down menu 

Variable Bit Rate ntity of the saved data - adapts to the dynamics of the audio 
ints in the 

Selects variable bit rate, i.e. the data flow per unit of time - and thus 
the qua
file. The bit rate, for example, can be lowered at quieter po
track. 

Select your desired quality level in the drop-down menu. 

Not available for WAV Encoder. 

Drop-down menu us determines the quality of the 
n, the more accurate. Bits 

Specifies the scan accuracy and th
individual scanner. The higher the bit sig

Only available for WAV Encoder. 

Option buttons 

Stereo / Mono 

Specifies which channels are recorded. 
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7 Compiling DVD-Videos or miniDVDs 
With Nero Linux you can burn DVDs made up of DVD-Video files from your hard drive. You 
can play your burned DVDs on almost all DVD players. 
The miniDVD is burned to CD. It uses the specification of a DVD and therefore has the same 
technical options and qualities as a DVD. However, playback is not guaranteed on all DVD 
players. 

You can use Nero Linux to burn a DVD Video and miniDVD if the DVD video title, i.e. a com-
plete DVD folder structure, is already available.  

To compile a DVD-Video or miniDVD, proceed as follows: 

1. Select the DVD or CD entry from the drop-down menu in the New Compilation window. (In 
case that the New Compilation window is not opened, it can be opened by clicking the New 
button on the main screen.) 

2. Choose the DVD Video or miniDVD compilation type from the selection list. 

 The tabs with the configuration options that are valid for this compilation type are dis-
played. 

 
DVD Video Tab 

3. Set the options you require on the tabs. 
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4. Click the New button. 

 The New Compilation window is closed and the selection screen is opened. It includes 
a compilation area for video and image files and an area for data. 

 
DVD Video Compilation Screen 

5. Select the video file that you want to burn from the browser area on the right side.  

6. Drag the existing DVD folder structure of the video title (VIDEO_TS) into the video compila-
tion area on the left side. 

 The files are added to the compilation and displayed in the compilation screen. The ca-
pacity bar indicates how much space is required on the disc. 

 You have successfully compiled a DVD-Video or miniDVD and can now burn this compi-
lation. 

See also: 

 Burn Compilation 44 
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8 Bootable Disc 
With Nero Linux you can create a bootable disc with which the computer can be started 
without having to access the hard drive. For this reason a bootable disc is often used as an 
"emergency disc" to start the computer if it is not possible to access the hard drive. 
Bootable discs are created in accordance with the "El Torito" standard, an extension to the 
ISO-9660 standard, which defines the structure of data discs. The disc contains a boot im-
age and an ISO part. The boot image contains all files that are required to load the operating 
system and to start the computer. The ISO part can contain any number of data files that you 
can back up using this method. 

8.1 Requirements for Booting From a Disc 
To ensure that a computer can boot from disc, the start sequence must be set in the BIOS of 
the computer in such a way that the drive is addressed first as the boot drive (start sequence 
CD-ROM, C, A for instance). In the case of an SCSI CD-ROM drive, this drive must be con-
nected to an SCSI adapter with a separate BIOS in which settings can be modified accord-
ingly. (This will only work if there are no IDE hard drives present, as these come before the 
SCSI adapter in the boot sequence.) 
When booting from a disc, you can only start an operating system that does not write to the 
medium, such as "MS DOS" or "Linux". During booting Microsoft Windows 2000 and Micro-
soft Windows XP write to the medium from which they are being booted. This is not possible 
with a disc and so the process is canceled and the PC cannot be started. 

8.2 Bootable Disc Template 
For Nero Linux, the template for creating a bootable disc can be either a logical drive or a 
drive image file which contains the contents of a drive as a file sector for sector. If the tem-
plate for the bootable disc is a logical drive, the bootable disc will emulate this when the sys-
tem is booting. There are three emulation types: 

 Floppy emulation: This requires a bootable floppy disc for creating the bootable disc. At 
startup the bootable disc emulates a floppy disk. In the process, the drive letters incre-
ment, so that Drive A: corresponds to the bootable disc. The volume of the start data is 
limited by the capacity of the floppy disk (e.g. 1 MB). 

 Hard drive emulation: A bootable hard drive is required to create the bootable disc. At 
startup the disc emulates Drive C. All drive letters from Drive C increment by one. The vo-
lume of the start data is limited by the capacity of the CD (e.g. 700 MB) or DVD (e.g. 8.5 
GB). If, for instance, you have a 200 GB hard drive with only one (200 GB) partition, you 
cannot create a bootable disc from it without repartitioning your hard drive accordingly be-
forehand. 

 No emulation: In this process the drive names are not changed. This type is used for 
bootable installation CDs. This setting is intended for users who do not require a floppy or 
hard drive emulation and who want to install their own device driver. 
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8.3 Creating and Burning a Bootable Disc 
To create a bootable disc, proceed as follows: 

1. Click the New button in the main Nero Linux screen. 

 The New Compilation window is opened. 

2. Select the desired disc format from the drop-down menu. 

3. Select the desired Boot compilation type. 

 The tabs for the bootable disc are displayed; the Boot tab is in front. 

 
Boot configuration 

4. If the template data for the bootable disc should originate from a logical drive: 

1. Select the Bootable logical drive option button in the Source of boot image data area. 
2. Select the entry you want from the drop-down menu. 

5. If the template data for the bootable disc should originate from an image file: 

1. Select the Image file option button in the Source of boot image data area. 
2. Click the Browse button and select the desired image file. 
3. Select the Enable expert settings check box and select the emulation type for the image 

file from the Kind of emulation drop-down menu if appropriate. 
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DosBootimage 

Nero Linux makes the boot image file DosBootimage.ima available. The path 
to the image file is entered in the Image file field by default. You can also select 
the language that should appear while the system is booting and select the cor-
rect keyboard layout from the Boot locale drop-down menu. 

DosBootimage is an image of the Caldera DOS boot floppy disk and emulates 
a floppy disk. The image contains drivers for reading from disc drives and sup-
ports FAT32 (read/write) as well as NTFS (read only). If you choose Dos-
Bootimage for the bootable disc, the expert settings are already predefined. 

 

 
Nero Linux provides already defined expert settings for Windows XP / Windows 
Vista or ISOLINUX bootable disc. You can select these in the Profile selection 
drop-down menu.  

6. Select any other options required on the tabs. 

7. Click the New button. 

 The selection screen is displayed.  

8. Select the files/folders that should be written to the ISO part of the bootable disc and drag 
them into the compilation area. 

 The files/folders are displayed in the compilation area and the capacity bar indicates how 
much storage space is required on the disc. You have now created the bootable disc and 
can start the burn process. 

See also: 

 Burn Compilation 44 
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9 Loading Image File 
You can use Nero Linux to burn a disc from a disc image that you have previously saved on 
the hard drive. 

To load a saved image file, proceed as follows: 

1. Select a recorder from the drop-down menu. 

2. Click the  button in the main screen. 

 The Open window is opened. 

3. Select the desired image file and click the Open button. 

 The Burn Compilation window is opened. 

4. Set the desired burn options. 

5. If technically possible, you can change the disc type in the drop-down menu. 

6. Click the Burn button. 

 The burn process is started. A progress bar indicates the progress being made by the 
burn process. When the burn process is complete the disc is ejected. 

 
 The burning process is complete. You can now remove the burned disc from the re-

corder. 
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10 Burn Compilation 

10.1 Choose Recorder Window 
In the Choose Recorder window you can select a recorder for burning. You can open the 
window via the button which is on the right side of the recorder drop-down menu. The win-
dow shows useful information about the recorder (e.g. supported disc types). In the ad-
vanced area you can set expert options. The available options depend on the chosen re-
corder. 

 
Choose Recorder 

The following setting options are available in the advanced area: 

Check box 

Buffer underrun 
protection 

Provides buffer underrun protection. 

This feature is particularly useful for burning CDs. 
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Check box 

Write extended 
lead-out on dou-
ble-layer discs 

Writes an extended lead-out of 515 MB on the second layer of a 
double-layer multisession DVD when this area contains less data. 
Doing so improves the read compatibility. 

This feature is particularly useful for burning a data multisession 
DVD on a double-layer disc. It is not needed when the DVD is going 
to be finalized. 

Check box 

DVD high com-
patibility mode 

Burns the DVD up to a radius of at least 30 mm (approx. 1 GB), 
even when the compilation contains less data. In doing so the DVD 
is forced to meet the DVD-Video specification which reduces the 
possibility of read errors. 

This feature is particularly useful for burning DVD-Videos. 

Check box 

BD defect man-
agement 

Burns the Blu-ray Disc in defect management mode. In doing so the 
burner allocates part of the disc so that it is once again able to burn 
the data that has been damaged in a write error. BD defect man-
agement reduces the write speed but increases data security. 

This feature is particularly useful for burning data Blu-ray Discs or 
for burning backups to Blu-ray Discs. 

Drop-down menu 

Book Type Set-
tings 

Defines the book type setting for a DVD. 

This feature is particularly useful for burning to a blank DVD. 

 

 
Four book type settings are available: 

Automatic: Automatically selects the most suitable book type for this DVD. 

DVD-ROM: Sets the book type to DVD-ROM. Select this setting if the DVD is to 
be played on several DVD players or your DVD player has difficulties with self-
burned DVDs or of the DVD-, DVD+ or DVD-RW specification. 

Physical disc type: Selects the book type which is specified on the DVD. 

Current recorder setting: Leaves the book type setting to the recorder. 

10.2 Starting the Burn Process 
 

 
Many CD players cannot read rewritable CDs (CD-RW). You should therefore 
use normal CD-ROMs for burning Audio CDs. 

To start the burn process, proceed as follows: 

1. Click the Burn button in the main screen. 

 The Burn Compilation window is opened; the Burn tab is in front. 
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Burn Compilation window 

2. Check or select the options on the individual tabs. 

3. Insert an appropriate blank disc and click the Burn button. 

 The burn process is started. On the screen a progress bar indicates the progress being 
made by the burn process. 

 When the burn process has finished, a message window is opened. 

4. If you want to display the extended area with the event log, click the Details button. 

5. If you want to start another burn process with the same compilation, click the Burn Again 
button. 

6. Click the OK button. 

 The burning process is complete. You can now remove the burned disc from the re-
corder. 
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1. 
2. 

10.3 Burning With Image Recorder – Creating an Image File 
To create an image file, proceed as follows:  

Click the New button. 

Create a new compilation of your choice. 
 

 
Using Nero Linux you can create image files for disc types that the installed re-
corder cannot burn. You can enable this function via the File > Options > Ex-
pert Features menu, Enable all supported recorder formats for image re-
corder check box. The drop-down menu in the Compilation window then ma-
kes available all supported disc types. 

3. Select the files that you want to burn. 

4. If you have installed multiple recorders, select Nero Image Recorder from the drop-down 
menu. 

5. Click the Burn button. 

 The Burn Compilation window is opened; the Burn tab is in front. 

6. Click the Burn button. 

 The Save Image File window is opened. 

7. Specify a file name and a storage location for the image file and click the Save button. 

 The image file is created and saved in the selected storage location. On the screen, a 
progress bar indicates the progress made while the file is being created. Once the crea-
tion process is over, a message window is opened.  

8. Click the OK button. 

 The message window is closed and you have successfully created the image file. 

See also: 

 Loading Image File 43 
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10.4 Burn Compilation Window 
In the Burn Compilation window you can set or select the required burn options and then 
start the actual burn process. The window consists of a drop-down menu, a selection list, va-
rious tabs, and buttons. 

 
Burn Compilation 

The selected disc format is displayed in the selection list on the left. If multiple disc types are 
available for this disc format and if you have installed a suitable burner, you can select an-
other disc type from the drop-down menu. 
The following buttons are available: 

Button 

Disc Info 

Displays information on the disc inserted, such as contents (if any) 
or available capacity for instance. 

Button 

Burn 

Starts the burn process if a burner is connected. 

If a burner is not connected, the Save Image File window is ope-
ned. 

This button is only available if the Write check box is cleared. 

Button 

OK 

Accepts all changes and closes the window. 

This button is only available if the Burn check box is cleared. 
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Button 

Cancel 

Closes the Burn Compilation window. 

10.5 Burn Settings 
The Burn tab on the Burn Compilation window provides options for the burn process. 

The following check boxes are available in the Action area: 

Check box 

Determine maximum 
speed 

Checks how fast the compiled data can be accessed and re-
duces the selected writing speed if necessary. This prevents 
a buffer underrun. 

Recorders with a feature to prevent buffer underruns do not 
require a speed test. 

Not available when saving with Nero Image Recorder. 

Check box 

Simulation 

Simulates burning. In the process the simulation performs all 
steps that are also carried out during burning with the excep-
tion of setting the laser beam. A test determines whether the-
re is a constant flow of data. 

Check box 

Write 

Enables the Burn button. 

Check box 

Finalize Disc 

Closes the disc so that you cannot write to this disc anymore. 
Depending on the disc format, finalizing may be necessary. 

Nero Linux automatically checks the box for the relevant disc 
formats. 

Check box 

Verify written data 

Checks the data written to the disc after the burn process. 
You can use this option particularly when burning backups to 
ensure that all data has been written correctly.  

This check box is only available if the selected recorder is not 
the Nero Image Recorder.  

The following configuration options are available in the Writing area: 

Drop-down menu 

Write method 

Selects the method used to burn the disc. Disc-at-once and 
Track-at-once are available. 

Disc-at-once: Burns the entire disc in one go without having 
to turn off the laser between individual audio files. 

Track-at-once: Burns each audio file (track) separately onto 
the disc, i.e. the laser is turned off and turned on again after 
each audio file. 

Input field 

Number of copies 

Defines the number of discs that are to be burned. The de-
fault is set to one disc. 
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Check box 

Buffer underrun protec-
tion 

Provides buffer underrun protection. 

This check box is only available if the selected burner sup-
ports a method which offers buffer underrun protection. 

 

 
The speed test and simulation are not required for recorders that have a func-
tion for protecting against buffer underruns. 

 

 
Audio CDs should always be burned using the disc-at-once method. This entry 
is selected by default. 
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 

11 Copying a Disc 

11.1 Methods of Copying 
Nero Linux can be used for copying discs. There are two methods for this: 

 On-the-fly 

 Copy Over Image 

Each method has advantages and disadvantages which will depend on your requirements. 

11.1.1 On-the-fly Copying 

When using the on-the-fly method, insert the original disc into a drive and a recordable disc 
into the drive. The original disc in the drive is copied immediately without any time delay to 
the blank disc in the recorder. The on-the-fly method allows you to copy discs very quickly, 
and does not require any additional space on the disc. 
In order to be able to use the on-the-fly method, you will need at least two drives: one for 
reading the disc and a disc burner for writing. The following requirements apply to the read 
drive and disc burner: 

The disc burner must feature buffer underrun protection, or the drive must be capable of 
delivering the data sufficiently quickly. The read speed should be at least twice as fast as 
the write speed.  

 The read drive must be capable of delivering information on the number and type of ses-
sions, otherwise Nero Linux may not be able to produce an exact copy.  

If you want to copy Audio CDs, we recommend the copy image method because the quality 
of the read audio files can suffer depending on the drive.  

11.1.2 Copy Over Image 

With the copy over image method, an image of the original disc is saved to a file first. The 
image file is then burned to a blank disc. Copying using copy over image takes longer, but it 
often produces better results. 
You must have sufficient storage space to use the copy over image method. 

The copy over image method is particularly suitable in the following situations: 

 Only one drive is available. 

 You would like to make several copies of the same disc. 

 You think it likely that read errors may have occurred on the source CD (for example be-
cause it is scratched). 

 You attach importance to the best possible reproduction (particularly in relation to index 
positions and the quality of Audio CDs). 
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11.2 Copying Disc 
 

 
If you are not in possession of the copyright for the relevant CD/DVD and do 
not have authorization from the owner of the copyright, unauthorized copying of 
CDs violates national and international legislation. 

 

 
Copy-protected Audio CDs cannot be copied using Nero Linux. 

 

 
Some CDs/DVDs are copy-protected and cannot be copied. If you are not sure 
whether your CD/DVD can be copied, activate simulation before commencing 
the actual physical burn process. 

To copy a disc, proceed as follows: 

1. Click the Copy button in the main screen. 

 The New Compilation window is opened. 

 
Copy Disc window 

2. Select the disc type you want from the drop-down menu. 

3. Carry out the desired settings on the tabs. 
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Copy Options tab 

4. If you want to copy discs using the On-the-fly method: 

1. Select the On the fly check box on the Copy Options tab. 
2. Select the drive that contains the disc to be copied from the Drive drop-down menu.  
3. Insert the disc that you want to copy into the selected drive. 
4. Insert a blank disc. 

5. If you want to copy discs using the Image Copy method: 

1. Clear the On the fly check box on the Copy Options tab. 
2. Insert the disc that you want to copy into the recorder. 

6. Click the Copy button. 

 If you are copying via the drive, the copy process starts. If you are using Nero Image Re-
corder, the Save Image File message window is opened. 

7. Enter a name for your image file in the File Name text box. 

8. Select the relevant storage location in the Save to directory tree and click the Save button. 

 The copy and/or save process starts. You can follow the process status in the status bar. 
If you are using a single drive for copying, you will be prompted to remove the source 
disc and to insert a suitable blank disc after the image file has been written. 
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9. Click the Next button. 

 You have successfully copied a disc. 

11.3 Copy Settings 
In the New Compilation window, define the options for copying at the beginning of the copy 
procedure. You can use the Copy button in the main screen to open the window. The New 
Compilation window consists of a drop-down menu, various buttons, and tabs.  

 
Copy settings 

Only those disc types supported by the recorder are displayed in the drop-down menu. If the 
recorder can only burn CDs, the drop-down menu is grayed out. 

 

 
Using Nero Linux you can create image files for disc types that the installed re-
corder cannot burn. You can enable this function via the File > Options > Ex-
pert Features menu, Enable all supported recorder formats for image re-
corder check box. The drop-down menu in the Compilation window then ma-
kes available all supported disc types. 
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The following configuration options are available: 

Button 

Disc Info 

Displays information on the disc inserted, such as contents (if any) 
or available capacity for instance. 

Button 

Copy 

Starts the copy process. 

Button 

Cancel 

Closes the New Compilation window. 

The following tabs are available: 

Image  Gives the path to the temporary image file and provides information 
on the speed of the hard drive. 

Copy Options Contains options for configuring copying. 

Read Options Contains options for configuring reading of the original disc. 

Writing Contains options for configuring the burn process. 
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11.3.1 Copy Options 

 
Copy Options tab 

In the Copy Options tag the following configuration options are available in the General 
Area. 

Check box 

On-the-fly copying 

Creates the copy using the on-the-fly method.  

If this check box is cleared, the copy is created using the copy-
over-image method. 

The following configuration options are available in the Copy Options tab in the source 
area: 

Drop-down menu 

Drive 

Selects the drive for reading the disc.  

If a copy over image is created, we recommend that you select 
the recorder for reading in. 

Drop-down menu 

Read speed 

Defines the speed at which the disc is read in. 

Check box 

Eject source drive on-
ce the read process is 
complete 

Ejects the source disc once the read process is finished so that 
you can insert the target disc. 
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11.3.2 Read Options 
The Read Option tab consists of several areas. In these areas it is possible to set options 
for reading an original disc. 

The following configuration options are available in the Profile area: 

Drop-down menu 

Profile selection 

Selects predefined copy settings or a user-defined setting. 

In the case of predefined copy settings, Nero Linux sets the con-
figuration options automatically. You can select the configuration 
options yourself with a user-defined setting. 

The following configuration options are available in the Database area for the CD disc type: 

Check box 

Ignore read errors 

Ignores read errors on the original disc and continues the read 
process. 

If this check box is cleared, Nero Linux may interrupt the burn 
process depending on the type of error. 

Check box 

Write defect sectors 

Still passes on corrupt sectors (that have caused read errors) for 
burning. 

If this check box is cleared, corrupt sectors are not passed on and 
remain blank. 

Check box 

Read sectors in raw 
mode 

Reads PQ subchannel data. 

Check box 

Read all subchannel 
data 

Reads all subchannel data. 

The following configuration options are available in the Audio Track for the CD area: 

Check box 

Ignore read errors 

Ignores read errors on the original disc and continues the read 
process. 

If this check box is cleared, Nero Linux may interrupt the burn 
process depending on the type of error. 

Check box 

Read indexes of au-
dio data 

Reads the audio file indexes. 

Check box 

Read all subchannel 
data 

Reads all subchannel data. 
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The following configuration options are available in the Advanced for the CD area: 

Check box 

Read Media Catalog 
Number and ISRC 

Reads the media catalog number, a globally unique number for 
compilations, and the ISRC (International Standard Recording 
Code), a globally unique number for audio recordings. 

Check box 

Use jitter correction 

Jitter corrector removes scratches from audio and video files. 

The following configuration options are available in the Error Correction for the DVD type 
disc: 

Option button 

Read with error cor-
rection 

Performs error correction while reading. In the process, the 
checksum of a corrupt sector is adjusted so that the sector in it-
self is consistent. 

Input field 

Read retry count 

Establishes the number of attempts that are made to correct er-
rors. 

Option button 

Fast reading without 
error correction 

Performs fast reading without error correction. 

The following configuration options are available in the Dealing with Non-Correctable Rea-
ding Errors for the DVD disc type: 

Check box 

Ignore read errors 

Ignores read errors on the original disc. 

If this check box is cleared, Nero Linux may interrupt the burn 
process depending on the type of error. 

 

 
With certain disc formats such as Audio CD, read errors often have little or no 
impact because they are not perceptible when the CD is played. 
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12 Erase Rewritable Disc Window 
Nero Linux can be used to erase rewritable discs, i.e. discs with the RW specification, as 
long as your recorder supports this feature. Two erase methods are available for this pur-
pose: 
Quick erasing does not remove the data physically from the disc, but instead only makes it 
inaccessible by erasing the references to existing content. The data can be restored! 
Full erasing removes the data from the disc by overwriting it with zeroes. The contents can-
not be restored with conventional methods. Repeated full erasing increases the probability 
that third parties will not be able to reconstruct the contents. 

 
Erase Rewritable Disc window 

The following configuration options are available in the Erase Rewritable Disc window: 

Selection list 

Select recorder 

Defines the desired recorder. 

Selection list 

Select the erase me-
thod to be used 

Defines the erase method. Two options are available: 

The Quick-erase rewritable disc method does not physically 
erase all data from the disc, but only the references to the con-
tents. The disc will appear to be empty even though the data is 
still physically available. Erasing a disc using this method takes 
between one and two minutes. 

The Full-erase rewritable disc method physically erases all 
data from the disc. The contents cannot be restored with con-
ventional methods. Repeated full erasing increases the prob-
ability that third parties will not be able to reconstruct the con-
tents. Erasing the disc using this method takes longer than the 
other method, depending on the type of disc involved. 
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Selection list 

Erase speed 

Defines the erase speed. 

Button 

Erase 

Starts the erase process. 

Button 

Cancel 

Cancels the action and closes the window. 
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13 Configuration Options 
You can define options for working with Nero Linux in the Options window.  

 
Options Window 

The following tabs are available: 

Compilation Contains options for the compilation and the selection screen. 

Cache Contains options for the cache. 

Sounds Contains selection options for sounds in connection with burn tasks. 

Audio Displays the directory for the audio plug-ins. 

Expert Features Contains options for configuring overburning and burning.  

We recommend that you retain the default settings. 

Audio CD Databa-
se 

Provides the option to use the Internet database. 

Ultrabuffer Defines the size of the RAM buffer. 
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System Configura-
tion 

Allows the system settings to be checked when the program is star-
ted. 

File Browser Contains options for configuring the file browser. 

Misc. Contains options for configuring compilations, burning, the data-
base, the user interface, as well as advanced settings.  

13.1 Expert Features 

The following configuration options are available on the Expert Settings tab: 

Check box 

Enable Disc-at-once CD over-
burning 

Enables additional options and defines settings for the 
entire burn process.  

Option button 

Relative/Absolute maximum 
overburning size 

Defines how much a disc can be overburned. 

Check box 

Enable DVD overburning 

Enables the option that DVDs can be overburned. 

Check box 

Enable generation of short 
lead-out 

Enables the option to write additional data to your CD. 

This feature is only available if the Enable Disc-at-
once CD overburning option is enabled. 

Check box 

Do not eject disc after burning 

Enables the option that your disc remains in the re-
corder and is not ejected when the burn process is fin-
ished. 

Check box 

Reload the disc after the burn 
is complete 

Enables the option that the disc is automatically re-
loaded after the burn process. 

Check box 

Allow to disable finalizing for 
burning a disc image 

Disables finalizing when an image file is saved. 

Check box 

Enable all supported recorder 
formats for image recorder  

Enables the option that all supported recorder formats 
for the Image Recorder are available. 

It is now possible to create compilations that the in-
stalled recorder cannot burn. For instance, you can 
create a Blu-ray compilation without a Blu-ray recorder 
and create an image file with Nero Image Recorder. 
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13.2 System Configuration 

The following check boxes are available on the System Configuration tab: 

Check if /proc and /sys are 
correctly mounted at startup 

Checks if the folders /proc and /sys are correctly moun-
ted. These folders contain files that are used by Nero 
Linux to detect when a device is added or removed. 

Perform device permissions 
checks at startup 

For further explanation on how to set permissions cor-
rectly see Setting correct permissions on the devices 
files 10. 

Check IDE devices driver at 
startup 

For further explanation on how to configure IDE de-
vices correctly see IDE devices configuration 9. 

Check if DMA acceleration is 
enabled for IDE devices at 
startup 

For further explanation on how to set DMA acceleration 
on IDE devices correctly see Setting up DMA accelera-
tion on IDE devices 11. 

Check for mounted devices at 
startup 

Checks for mounted devices. If a disc is mounted in a 
drive, then Nero Linux might not be able to use this de-
vice. 

See also: 
 

 Device File Names 8 
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14 Technical Information 

14.1 System Requirements 

14.1.1 General System Requirements 

To install Nero Linux you need administrator rights. 

Processor and installed memory: 

 800 MHz Intel Pentium III processor, AMD Sempron 2200+ processor or equivalent 

 At least 128 MB RAM or more 

Hard disc space: 

 50 MB for program installation 

 700 MB free hard drive space for CD images and temporary files 

 Up to 9 GB free hard drive space for DVD images and temporary files 

 Up to 50 GB free hard drive space for Blu-ray Disc BD-R/RE dual layer disc images 

Optical device: 

 CD, DVD or Blu-ray recordable or rewritable drive for burning 

Optional: 

 Sound device and speakers 

 Internet connection for updating the application, downloading the Help file; and freedb 
services. The costs for the Internet connection are carried by the user. 
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14.1.2 Linux Kernel Requirements 

 

Kernel version 2.4 or higher (2.6 recommended) with X-Window 

Glibc 2.3.6 and libstdc++6 4.1.1 (or higher) 

GTK+ 2.8.0 (or higher) 
 

 
How to get the Linux kernel version 

To find out which Linux kernel you are using you can enter uname –r into a ter-
minal.  

 

 
The kernel is the heart of your Linux system. For example, the kernel provides 
low-level drivers which gain access to devices. 
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14.1.3 Supported Distributions 

Nero Linux supports the following distributions: 

 Red Hat Enterprise Linux 5 

 SuSE Linux 10.3 

 Fedora 7 

 Debian GNU/Linux 4.0 

 Ubuntu 7.04 

The distributions are supported as of the indicated versions. 

14.2 Formats Supported 

14.2.1 Disc Formats 

 Audio CD 

 Mixed mode CDs 

 CD EXTRA 

 miniDVD 

 DVD-Video 

 Nero Image (NRG) 

 CUE-Image 

 ISO-Image 

14.2.2 Disc Types 

 CD 

 DVD 

 Blu-ray - burning only 

 
You can find more information on Blu-ray support at 
www.nero.com/link.php?topic_id=416. 

 

 
The actual entries that are available and the actual disc types (e.g. DVD) to 
which can be written depend on the used recorder. 

14.2.3 Audio Formats and Codecs 

 MP3 / mp3PRO 

 Moving Picture Experts Group-1 Audio Layer 3 (MP3) 

 OGG Vorbis (OGG, OGM) 

 Resource Interchange File Format WAVE (WAV, WAVE) 
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 Free Lossless Audio Codec (FLAC) 

 Linear Pulse Code Modulation (LPCM, PCM, L16) 

 Musepack (MPC) - only decoding 
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15 Glossary 

AIFF 
The Audio Interchange File Format is an uncompressed audio file format from Apple® and 
represents a sort of counterpart to the WAV format from Microsoft. Files are larger than 
when using a compressed format, but the quality is higher. AIFF compressed is the com-
pressed variation. 

Book Type 
The book type defines the specification (e.g. DVD-, DVD+, DVD-ROM) of a DVD. In order to 
ensure correct playback, the DVD specifications are defined in books so that all media can 
be read correctly. The specifications are defined in the so-called Rainbow Books, which are 
distinguished by means of their color (e.g. Yellow Book). 

Bootable CD 
Booting refers to loading the operating system when a computer is started. This is normally 
done from the hard drive. However, if you do not want to boot or cannot boot your computer 
from your hard drive for whatever reason, you can load an operating environment from the 
drive with a boot CD. 

Buffer Underrun 
A buffer underrun is an interruption in the data flow in the internal memory (e.g. of the re-
corder). A buffer underrun results from an interruption in the data flow to the internal buffer. 
The buffer continues to deliver data until it is finally empty. When recording, data is fed con-
tinuously to the recorder's buffer in order to keep a steady flow of data. If the steady flow of 
data is interrupted, the media becomes unusable. Most modern recorders have a protective 
mechanism against buffer underruns. 

CD-R 
Compact Disc-Recordable is a technology for write-once media. The Orange Book standard 
defines the storage of audio data and other computer-readable data. 

Disc-At-Once 
Disc-At-Once refers to a method in which the laser in your recorder burns straight through in 
one session without turning off and on between each track. This method is best when re-
cording Audio CDs you would like to play in your home or car stereo. 

Frame 
With an Audio CD, 75 sectors provide one second of played music. One sector consists of 
up to 98 frames; one frame contains 24 data bytes and 9 control bytes. Similarly, "frame" de-
scribes a full screen in television and video technology. Two successive half images result in 
a full screen within a second due to interlacing. 

Image 
An image refers to a single file on the hard drive that contains the image of a complete disc. 
A disc image can be used to create exact copies on media at a later point in time if problems 
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occur during the write process or if no recorder is connected to your PC. The image requires 
as much free space on the hard drive as the contents of the original disc take up. 

Jitter 
Jitter refers to an abrupt and undesired change in the signal characteristics. Small gaps oc-
cur in the data stream as a result. Audio correction synchronizes the data by overlapping the 
sectors. This way, the gaps are not audible. 

Joliet 
Joliet refers to an extension of the ISO-9660 standard for file names. Joliet was designed by 
Microsoft in order to represent more characters. The file name can be up to 64 characters 
long and contain the letters A-Z, a-z, umlauts, and the ß. 

MP3 
The MPEG-1 Audio Layer 3 audio format is used to reduce the size of audio files to a frac-
tion of their original size (factor 1:10) with little loss of quality. You can estimate about 1 MB 
per minute as opposed to 10 MB for the original files. This value and the quality can vary de-
pending on the complexity of the audio signal. The bit rate used can be used as a measure 
of quality. The higher the bit rate, the better the quality, but also the more memory required. 

Multisession 
A multisession refers to completing a disc in multiple cycles. After a first session has been 
written to the disc, information can then be added in another record because the disc has not 
been finalized. 

Subchannel data 
Subchannel data on a disc contains additional information, such as CD Text or information 
on positions. 

WAV 
The WAV audio format, also called WAVE or Waveform audio format, is an audio format 
from Microsoft and uses no data compression. WAV is the counterpart to the AIF format from 
Apple. 
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